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Understanding Fixed Asset Manager
Welcome to the QuickBooks Fixed Asset Manager software program. Use Fixed 
Asset Manager to enter and maintain information about client assets. Key 
features of Fixed Asset Manager include:

● A detailed asset entry screen that you can customize
● Up to five user-defined classifications for tracking assets
● Six depreciation bases (Book, State, Federal, Other, AMT and ACE)
● Projected depreciation calculations
● Disposition tracking
● On-screen queries and custom sorting options for the asset list
● Full calculation overrides
● A report list feature that allows you to group commonly-used reports for 

easy access and printing
● An export feature that allows you to transfer asset information into ProSeries 

federal tax products
● A desktop workspace that you can customize
● A toolbar that gives you quick access to common tasks

Getting help in Fixed Asset Manager
Fixed Asset Manager provides a variety of options to help you learn the product 
in a way that best suits your needs.

Using the Help menu commands
To see the Help menu, go to the menu bar and select Help.

Tip: A good way to learn about Fixed Asset Manager is to go through the Fixed 
Asset Manager tutorial. For more information, refer to the section titled 
“Using the Tutorial” on page 4.
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The following table describes the commands on the Help menu:

Using Help Topics
To review the details of a specific procedure, command, option or topic, go to the 
Help menu and select Help Topics.

The Contents tab is selected in the following illustration of the QuickBooks 
Fixed Asset Manager Help:

Use this command To do this

Help Topics Search for topics using the Contents, Index, and 
Search features.

Getting Started Tutorial View a topic that introduces a tutorial showing you 
how easy it is to learn about and use QuickBooks 
Fixed Asset Manager. This tutorial covers the basic 
features and functions of Fixed Asset Manager so 
you'll be up and running quickly.

Printable Manual Open the Fixed Asset Manager User’s Guide.

Readme Open the Fixed Asset Manager ReadMe file.

About Fixed Asset 
Manager

See information about the software, such as the 
version number.

Click these tabs 
to use the 
Contents, Index 
and Search.

Click a topic in 
the list to view 
it.

Double-click a 
book to view its 
contents.
Getting Started 3



Using the Tutorial
To learn about basic Fixed Asset Manager features, such as setting up and 
maintaining, go to the Help menu and select Getting Started Tutorial.

Using context-sensitive help
To use context-sensitive help, first click the Help button on the toolbar, and then 
click the button or command about which you want information.
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Starting Fixed Asset Manager
To access Fixed Asset Manager:

1 Double-click the QuickBooks shortcut icon on your desktop.
2 Open the QuickBooks company file that includes the fixed assets you want 

to calculate or review.

 

3 If using QuickBooks: Premier Accountant Edition, go to the Accountant 
menu, select Manage Fixed Assets.
If using QuickBooks Enterprise Solutions, go to the Company menu, and 
select Manage Fixed Assets.
If this is the first time you accessed the Fixed Asset Manager for this 
QuickBooks company, you need to create a new Fixed Asset Manager client 
associated with this QuickBooks company. For more information on creating 
the new client file, refer to the next section titled “Creating a new client file.”

Creating a new client file
To open a new client file and begin entering asset information, you must first 
enter basic client file information and determine the type of information that you 
want to maintain. The New Client Wizard steps you through this process.

1 If using QuickBooks: Premier Accountant Edition, go to the Accountant 
menu, select Manage Fixed Assets. If using QuickBooks Enterprise 
Solutions, go to the Company menu, and select Manage Fixed Assets. A 
message appears indicating that there is not a Fixed Asset Manager client 
associated with the current QuickBooks company.

Important: Before you access the Fixed Asset Manager, you must make an Income Tax 
Form Used selection in QuickBooks. Make the form selection in the Company 
Information window in QuickBooks. To get to this window in QuickBooks, 
go to the Company menu and select Company Information.

Important: Fixed Asset Manager cannot be accessed if more than version of QuickBooks 
is running on the same workstation at the same time.
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2 Select Create a new Fixed Asset Manager client. The Introduction page of 
the New Client wizard appears. Click Next to continue.

3 The New Client - General page appears with information from the 
QuickBooks company. Review the company information. You must go to the 
Company Information window in QuickBooks if any changes to the 
information are necessary. Click Next to continue.
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4 Enter the Beginning of Year and End of Year dates for the client.

5 In the Prior Short Years section, click Add to enter short year dates, if 
applicable for the client.
Enter the Beginning of Year and End of Year dates, then click OK.
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6 Form 1120 clients only: Indicate whether the client is a qualified small 
corporation, then click Next.

7 Select one or more bases to use for this client file, then click Next.

8 Review the default methods for each tax system and make changes if 
needed, then click Next.

Tip: To edit a prior short year date, go to the Prior Short Year section of the Dates 
window, select the dates, then click Edit. To delete a prior short year date, go 
to the Prior Short Year section of the Dates window, select the dates, then 
click Remove.
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9 Select how you want the fixed asset information to be brought in from 
QuickBooks by choosing the appropriate Asset Synchronization - From 
QuickBooks options. Click Next to continue.

10 Select how you want the fixed asset information to be saved to QuickBooks 
by choosing the appropriate Asset Synchronization - To QuickBooks 
options. Click Next to continue.
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11 In the Summary page, review the information, then click Finish.

The new client file appears in the Fixed Asset Manager window, with the 
Schedule tab and folder selected.
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Updating client information
To view and change some of the basic information that you entered in the New 
Client wizard when you created the client file, take the following steps:

1 From the File menu, select Client Information.

2 In the Client Information window, update the client’s information by 
selecting options described in the following table.

Important: You cannot change the general client information in Fixed Asset Manager. Go 
to the Company Information window in QuickBooks to make any changes.

Select this tab To do this

General View the client name, address, and phone numbers.

Dates Change the beginning of year and end of year dates for the 
client, along with any prior short-year history. You can also 
indicate whether a new 1120 client file qualifies as a small 
corporation.

Basis Modify the bases that you want to track for the client file.

Methods Change the default methods that you want to use for the 
client file.
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Understanding the Fixed Asset Manager window
When you open Fixed Asset Manager, the Fixed Asset Manager window appears 
with the Schedule folder open.

While elements of the Fixed Asset Manager window vary depending on which of 
the six tabs is selected and which action you are performing, the major areas of 
the window do not change. The following illustration highlights the major 
elements in the Fixed Asset Manager window:

Using the title bar
The title bar identifies the QuickBook company client file that’s currently open.

Groupings Modify the pick list for the grouping fields provided in the 
Asset folder.

Accounts View the list of accounts to which you can assign assets for 
general ledger tracking.

Select this tab To do this

Title bar
Menu bar
Toolbar
Tab toolbar

Asset toolbar

Basis tabs

Total line

Status bar
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Using the menu bar
Each command on the menu bar displays a menu of commands that are 
summarized next.

Using the toolbar
The toolbar appears directly below the menu bar, and contains buttons that are 
shortcuts to commands that are also found on the menus. To see a description of 
the function of a toolbar button, point to the button.

Use the Toolbar command on the View menu to hide or show the toolbar.

Changing 
what appears 
on the screen

Working 
with client 
files

Working with 
asset 
information

Using 
various 
tools

Cutting, 
copying and 
pasting data

Working with 
QuickBooks

Working with 
reports and tax 
worksheets

Getting help 
and 
information

Save the 
current file

Print reports, 
tax worksheets 
or labels

Cut the 
selected text

Insert the cut 
or copied text

Delete the 
current asset

Go to
next asset

Display QuickBooks 
Transaction Report

Perform Section 
179/40% test

Access common 
Asset Tools

Preview reports, 
tax worksheets 
or labels

Copy the 
selected text

Add an 
asset

Go to
previous asset

Search for 
an asset

Display 
depreciation totals

Display 
help for 
selected 
item

Tip: To see more information about the function of a button, click the Help button 
(on the right end of the toolbar), then click the button you want to learn about.
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Using shortcut menus
In several places throughout the program, you 
can click the right mouse button to view a 
shortcut menu with common tasks for that 
particular area.

Shortcut menus are available in the Schedule, 
Asset, Projection, Notes and Calendar folders. 
The main shortcut menu for the Schedule folder 
is shown on the right.

This shortcut menu appears when you right-click 
a column heading in the Schedule folder and it 
contains commands that allow you to modify 
Schedule views.

Using the Tab toolbar
The Tab toolbar contains six tabs — Schedule, Asset, Disposal, Projection, 
Notes, and Calendar. When you click a tab, the corresponding folder opens.

Selecting a tab and corresponding folder
To view or edit information in one of the six folders, click the tab that 
corresponds to the folder that you want to use.

The first folder in the Fixed Asset Manager window is the Schedule folder. In 
this folder, assets appear in a tabular list with columns that you can use to select 
and sort. Totals for each numeric column appear on the Totals line.

Tabs at the bottom of the work area allow you to view information for a specific 
basis (Federal, AMT, ACE, Book, State and Other). For detailed information 
about customizing the contents of the Schedule folder, refer to the section titled 
“Defining column sets for the Schedule folder” later in this chapter.

Important: You can also use commands on the View menu to open a folder.

Important: When you go to the Asset, Disposal, Projection or Notes folder, you see 
information about the asset that’s selected in the Schedule folder.
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Using the status bar
The status bar shows you the basis that you’ve chosen for the current asset, the 
total number of assets on the list, and the year-end date of the client. When you 
select a command on a menu, you can see a description of that command on the 
status bar.

When you’re viewing the Schedule folder, the status bar presents information 
about the current client and selected asset. When you’re not viewing the 
Schedule folder, the status bar indicates which asset you are editing and includes 
other information about the asset. For example, it might tell you to recalculate or 
save the asset.

Use the Status Bar command on the View menu to hide or show the status bar.

Selecting program options
To customize your program settings, go to the Tools menu and select Program 
Options. When the Program Options window appears, the tab that was last 
viewed is selected. To select options from another section of the Program 
Options window, click the appropriate tab.

Use this folder For this purpose

Asset Enter general information about each asset, such as the 
account number and description, custom groupings and links 
to tax forms. The bottom half of this folder shows calculations 
and depreciation criteria, such as the tax system, method and 
convention.

Disposal Enter information regarding the sale of an asset.

Projection Presents projected depreciation calculations for the life of the 
asset.

Notes Enter comments about the current asset. You can add a note to 
each asset.

Calendar Presents a monthly view of the date each asset was placed in 
service. Any assets placed in service on a specified day are 
listed on that calendar date. Assets also appear by their 
disposition date. Use the Calendar folder to locate and edit 
assets.
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After you select the options that you want, click OK. Fixed Asset Manager uses 
the settings that you selected for the current client’s file.

Selecting General options
The following options are available from the General tab:

Tip: You can select and clear most options by selecting the check box to the left of 
the item.

Use this option To do this

Messages Select whether you want to receive a message before you 
add another asset, exit the program, delete an asset or list, 
make inclusions and exclusions from a query or after you 
post a journal entry.

Calculation Select whether you want to calculate assets automatically 
when you modify them.

Options Select whether you want to automatically compress clients 
or show client information alerts.
Starting and Setting Up Fixed Asset Manager 17



Customizing the Fixed Asset Manager window
Use the Views tab to customize the Fixed Asset Manager window.

Selecting text and background colors
Click the Color tab to change the text and background colors for various on-
screen elements of Fixed Asset Manager:

Use this option To do this

Window Show or hide the toolbar, the asset toolbar, and the status 
bar. Show or hide grid lines that define rows and columns on 
the schedule and change their color.

Show Activate and disable tooltips, which are explanations that 
appear when you point to a button. Lock or unlock the totals 
line at the bottom of the Schedule folder.
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To change the colors of various Fixed Asset Manager fields:

1 Select one of the following text items:
• Normal fields — Includes any fields in the folders that do not fit into any 

of the categories below except the Schedule folder.
• Disabled fields — Fields that do not apply to the active asset.
• Calculated fields — Includes current depreciation, unrecovered basis, 

accumulated depreciation, and any other field that Fixed Asset Manager 
calculates automatically.

• Overridden fields — Calculated values that you have replaced with 
manual entries.

• Static text — Descriptive text that you cannot edit including the 
Schedule folder.

2 Select a text color and a background color from the list.
3 Repeat steps 1 and 2 as needed.

To change the colors of the tabs on the Tab toolbar:

1 Click Use colors on tabs to activate tab colors.
2 Select a tab.
3 Select a text color and a background color from the list.
4 Repeat steps 2 and 3 as needed.

To return all items to their default color, click Reset to Default.
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Changing fonts
Use the Font tab to change the font, style and size of the font used to display 
data.

Selecting a calculator program
Fixed Asset Manager is set up to use the standard Windows calculator. The path 
to this calculator is:

The Tools tab allows you to use a different calculator while running Fixed Asset 
Manager.

Use this option To do this

Font Select the font that you want to use.

Font Style Indicate which style of the active font to use. For most fonts, 
select Regular.

Size Select the height of the font in points.

Sample View how your font selections appear.

Windows® XP C:\WINDOWS\SYSTEM32\CALC.EXE

Windows® Vista C:\WINDOWS\SYSTEM32\CALC.EXE
20 Chapter 2 www.quickbooks.com



Selecting QuickBooks asset synchronization options
By default, QuickBooks and Fixed Asset Manager share information while 
maintaining separate data files in separate locations.

Setting the options to automatic synchronization pulls asset data from 
QuickBook’s fixed asset item list when Fixed Asset Manager is opened or when 
a change is made within QuickBooks while Fixed Asset Manager is open, and 
you switch from QuickBooks back to Fixed Asset Manager.

Fixed Asset Manager allows you to designate how often and when this asset 
information gets shared.

To set the asset synchronization options:

1 From the QuickBooks menu, select Asset Synchronization Options.
2 Click the From QuickBooks tab to make the selections on how you want to 

update fixed asset items from QuickBooks.
3 Click the To QuickBooks tab to make the selections on how you want to 

save asset information to QuickBooks.
4 Click OK to save your changes.

Defining column sets for the Schedule folder
The Schedule folder lists asset information in a series of columns. The 
information that appears in each column flows from the data fields in the Asset 
or Disposal folders.

Applying a column set to the Schedule folder
Fixed Asset Manager comes with these standard column sets: Asset Listing, 
Category Listing and Lead Schedule.

Important: Synchronization between Fixed Asset Manager and QuickBooks will be 
disabled if more than one version of QuickBooks is running on the same 
workstation at the same time.

Important: Some client information can be found only in the Disposal folder or in the 
depreciation reports that you create.
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To view a different column set, make a selection from the View column set list 
on the Asset toolbar.

Creating a custom column set
You can customize the columns that you want to see in the Schedule folder, and 
place columns in the order that you want.

To create a custom column set:

1 Click the Create or modify column selections button on the Asset toolbar.
2 In the View Options window, click New.
3 In the New Column Set window, enter the description you want to use for 

the set, then click OK.
The new column set name appears in the Column Set list.

4 Go to the Available Columns list and select the columns you want to 
include in this column set.

Create or modify column selections button

Select a column.

Click Add>> to add 
the column that’s 
selected in the 
Available Columns 
list to the Selected 
Columns list.

Click 
<<Remove to 
remove the 
selected 
column from 
the Selected 
Columns list.

Click OK to save and 
apply this column 
set.

Click 
Properties to 
change 
column 
properties.

Click Move 
Up and Move 
Down to 
move the 
selected 
column up or 
down.

Tip: Double-click a column to move it from one list to the other.
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Copying an existing column set
You can copy an existing column set, change the column selections, then save the 
column set with a different name.

To copy a column set:

1 Click the Create or modify column selections button on the Asset toolbar.
2 In the View Options window, select an existing column set from the list.
3 Click the Copy button. You’ll notice the column set name that you copied 

appears with a number appended to it, e.g. “Asset Listing(2).”
4 Click the Edit button to change the description of the column set.

Setting column order
In the Schedule folder, columns appear in a specific order. When you create a 
custom column set, the columns appear from left to right in the Schedule folder 
in the order that you add them to the custom column set.

To adjust the position of a column in a custom column set:

1 Click the Create or modify column selections button on the Asset toolbar.
2 In the Selected Columns list of the View Options window, select the 

column you want to reposition.
3 Click the Move Up or Move Down buttons.
4 Repeat steps 2 and 3 for each column that needs to be adjusted.
5 Click OK.

Setting column properties
To adjust the width of each column or “lock” the column so it remains in the 
Fixed Asset Manager window as you scroll across the Schedule folder:

1 Click the Create or modify column selections button on the Asset toolbar.
2 In the Selected Columns list, select the column you want to change.
3 Click Properties, then change the width of the column or “lock” the column.

Tip: You can also change the order of the columns with your mouse using the drag-
and-drop method.
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4 Click OK.

Editing an existing column set
To edit a column set:

1 Click the Create or modify column selections button on the Asset toolbar.
2 In the Column Set list, select the column set you want to edit.
3 Go to the Selected Columns list and make the changes you want.

• Use Move Up or Move Down to change the order of the columns.
• Use Add or Remove to change the columns in the set.

4 Click OK.

Deleting a column set
To delete a column set:

1 Click the Create or modify column selections button on the Asset toolbar.
2 In the Column Set list, select the column set you want to delete, then click 

Delete.
3 When the confirmation appears, click Yes, then click OK.

Sorting assets in the Schedule folder
Assets appear in the Schedule folder by asset number and in ascending order. 
You can sort assets differently by changing the sort set, which is a set of criteria 
used to sort the assets. In addition, you can choose to edit an existing sort set or 
create a custom sort set.

Selecting a sort set
The standard sort sets are Asset Number, Asset Description, Category and 
Date Acquired.
24 Chapter 2 www.quickbooks.com



To use a different sort set, make a selection from the Sort assets by list on the 
Asset toolbar.

Creating a sort set
To create a new sort order:

1 Click the Create or modify sort criteria button on the Asset toolbar.
2 In the View Options window, click the Sort tab.
3 Click New, enter a description for the new sort set, then click OK.

4 Choose whether assets appear in ascending or descending order.
5 Select a field from the Available Fields list, then click Add.
6 Click OK to save and apply this sort order.

Create or modify sort criteria button

The description 
you entered 
appears here.

Tip: Double-click a field to move it from one list to the other automatically.
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Copying an existing sort set
You can copy an existing sort set, change the sort criteria, then save the sort set 
with a different name.

To copy a sort set:

1 Click the Create or modify sort criteria button on the Asset toolbar.
2 In the View Options window, select an existing sort set from the list.
3 Click the Copy button. You’ll notice the sort set name that you copied 

appears with a number appended to it, e.g. “Asset Number(2).”
4 Click the Edit button to change the description of the sort set.

Changing the sort order criteria
You can apply a hierarchy to the fields in the Sort Criteria list. The first field in 
the list is the primary sort. Subsequent selections are applied in the order they 
appear.

To adjust primary and secondary sort criteria:

1 Click the Create or modify sort criteria button on the Asset toolbar.
2 In the View Options window, click the Sort tab.
3 Select a field from the Sort Criteria list, then click Move Up or Move 

Down.
4 Click OK.

Editing an existing sort set
To edit a sort set:

1 Click the Create or modify sort criteria button on the Asset toolbar.
2 In the View Options window, click the Sort tab.
3 In the Sort Set list, select the sort set you want to edit.
4 Go to the Sort Criteria list and make the changes that you want.

• Use Move Up or Move Down to change the sorting hierarchy of the 
fields.

• Use Add or Remove to change the fields in the sort criteria.
5 Click OK.

Deleting a sort set
To delete a sort set:
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1 Click the Create or modify sort criteria button on the Asset toolbar.
2 In the View Options window, click the Sort tab.
3 In the Sort Set list, select the sort set you want to delete, then click Delete.
4 When the confirmation window appears, click Yes, then click OK.

Creating custom queries
This section describes how to create and save queries that you can apply to the 
fixed asset list. You can view and print subsets of assets based on criteria that you 
define.

There are two levels of queries — Basic and Advanced.

Selecting a query
The standard query sets are All Assets, All Assets Disposed, Assets Disposed in 
Current Year, Assets not Disposed in Current Year, and Current Year 
Assets.

To use a different query, make a selection from the Apply query criteria list on 
the Asset toolbar.

Defining a basic query
To define a basic query using the Query wizard:

1 Click the Create or modify asset selection criteria button on the Asset 
toolbar.

2 In the View Options window, click the Query tab, then click New to start 
the Query wizard.

3 Select Basic, then click Next.
4 Go to the Select a field list and select the first field that you want to use for 

the query. For a description of each field, refer to the Help topic titled 
“Understanding field definitions.”

Create or modify asset selection criteria button
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5 In the Select an operator list, select the type of operation you want to use.
6 In the Select or enter a value box, type a value that you want to use.
7 Click Add to add the query to the Query Display list.
8 To set more than one condition in the query, select And or Or, then repeat 

steps 4 through 7.
9 To replace a query line, select it from the Query Display list, then repeat 

steps 4 through 6 and click Replace.
To remove a query line, select it, then click Delete.
To remove all the query lines, click Clear All.

10 When your query is complete, click Next.
11 Type the name of the new query, then click Finish.

Defining an advanced query
To define an advanced query using specific dBase™ functions that you enter:

1 Click the Create or modify asset selection criteria button on the Asset 
toolbar.

2 In the View Options window, click the Query tab, then click New to start 
the Query wizard.

3 Select Advanced, then click Next.
4 Double-click each field, function or operator that you want to use. Fixed 

Asset Manager automatically adds selections to the end of the expression. 
For a description of each field, refer to the Help topics titled “Understanding 
query functions” and “Understanding query operators.”
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5 When your query is complete, click Next.
6 Type the name of the query, then click Finish.

Copying an existing query
You can copy an existing query, change the query selections, then save the query 
with a different name.

To copy a query:

1 Click the Create or modify asset selection criteria button on the Asset 
toolbar.

2 In the View Options window, select an existing query from the list.
3 Click the Copy button. You’ll notice the query name that you copied appears 

with a number appended to it, e.g. “All Assets Disposed(2).”
4 Click Edit to open the Query wizard.
5 Click Next when you have finished with your query selections. You can 

change the query name in the Query Wizard - Finish page.
6 Click Finish to start the query.

Editing an existing query
To edit an existing query:

1 Click the Create or modify asset selection criteria button on the Asset 
toolbar.

2 In the View Options window, click the Query tab.
3 Select the query you want to edit, then click Edit.
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4 Add, replace or delete expressions.
5 When your query is complete, click Next.
6 Type the query name, then click Finish.

Deleting a query
To delete an existing query:

1 Click the Create or modify asset selection criteria button on the Asset 
toolbar.

2 In the View Options window, click the Query tab.
3 Select the query you want to delete, then click Delete.
4 Click Yes when the confirmation appears, then click OK.

Customizing fields in the Asset folder
You can add or remove fields from the General Ledger Accounts section and 
the Groupings section of the Asset folder.

To add or remove a field in the Asset folder:

1 From the View menu, select Options.
2 Click the Fields tab.

Fields that are 
currently selected to 
appear in the Asset 
folder are indicated 
by the check mark.
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3 To add or remove a field in the Asset folder, select the check box next to the 
field name to add or remove the check mark.

4 Click OK.

Backing up and copying a client file
To back up a client file to another drive or to a floppy disk:

1 From the File menu, select Backup.
2 When the Backup window appears, click Browse to select the location for 

the backup file. 
3 Click Backup to continue to back up the Fixed Asset Manager client file.

It is important to remember that these files are separate from the 
QuickBooks clients files, and that both should be backed up regularly.

To restore a previously backed up client:

1 From the File menu, select Restore.
2 When the Restore window appears, click Browse to select the location of 

your backed up client file. 

3 Click Restore to continue to restore the Fixed Asset Manager client file.

Tip: Click your right-mouse button in the Asset folder, then select or clear the field 
that you want to add or remove.

Important: Because of the link between QuickBooks client files and Fixed Asset Manager 
client files, you should always use the backup and restore functions and not 
other means to manipulate or copy client files. 

Important: You cannot restore a backup from a previous version.

If you do not have a current backup to restore, you can run the Transfer Client 
routine again for this client.

To restore a previous version backup, you must install that version of Fixed 
Asset Manager and restore the backup. After you do that, run the Transfer 
Client routine in the current version of Fixed Asset Manger to transfer the 
fixed assets to the current tax year.
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Transferring information from prior-year client files
To transfer information from client files for the prior-year version of QuickBooks 
Fixed Asset Manager or ProSeries Fixed Asset Manager into this year’s version 
of Fixed Asset Manager, take the following steps:

1 From the File menu, select Transfer Client.
2 Read the information in the Introduction page, then click Next.
3 Select the client file you want to transfer and click Next.

4 In the Calculation Options page, first choose whether to prepare transferred 
client files for next year.
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If you choose not to prepare the client files for next year, you can choose:
• Do not recalculate assets
• Recalculate assets and exclude any prior depreciation values
• Recalculate assets and include prior depreciation values that are zero
• Recalculate assets and all prior depreciation values

5 When you finish making selections, click Next.

6 Select the appropriate Asset Synchronization - From QuickBooks options. 
Click Next to continue.

7 Select how you want the fixed asset information to be saved to QuickBooks 
by choosing the appropriate Asset Synchronization - To QuickBooks 
options. Click Next to continue.

8 In the Summary page, review your transfer selections, then click Finish.
A Transferring... window appears while the program transfers your client 
files.

9 At the conclusion of the transfer procedure, you are asked if you want to 
view an exception log that identifies any errors that occurred. Click Yes.

10 Review the information in the Exception Log window.
11 Click OK.

If you select No - Do 
not update these 
clients here...

...these options are 
available for you to 
select a calculation 
option.

Important: All 1120 clients for 1998 or later — If the Qualifying Small Corporations 
page appears, indicate whether each client file currently qualifies, no longer 
qualifies, or never qualified for the Small Corporation exemption from 
Alternative Minimum Tax.
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Importing asset data from Comma Separated Value files
You can import depreciation information from another fixed asset management 
program into a Fixed Asset Manager client file if the other fixed asset 
management program can save asset data to a Comma Separated Value (CSV) 
format file. CSV format, which is recognized by most word processing and 
spreadsheet applications, uses the .csv file name extension.

Preparing a CSV format file
The imported CSV file must be in a format that is usable to Fixed Asset Manager. 
Use these guidelines to prepare your client file for importing:

● A single CSV file can represent only one client’s data. (In other words, there 
must be one CSV file for each client).

● Each row of data can represent only one asset. Each column must contain the 
same type of data. (For example, the asset names should be in the same 
column).

● Each row of client data must have the same number of columns.
● The file can have column headings.
● While there can be blank rows at the beginning of the file, after the first row 

of client data is defined, there can’t be any more rows without client data.
● Although commas must separate all values, the individual values in the 

record can be enclosed with double quotes.

Importing asset data from a CSV format file
Before importing asset data from another depreciation program, make sure that 
you’ve set up a Fixed Asset Manager file to receive the imported data. The Fixed 
Asset Manager file must have the same characteristics (such as, tax return type 
and fiscal year dates) as the file from which you’re importing asset data.

Tip: If the other fixed asset management program can’t save to a file in CSV 
format but can save to a file in a format that is readable by Microsoft Excel, 
save the asset data to a file in the format that is readable by Excel, open that 
file in Excel, then save the asset data in CSV format.

Tip: To verify that a file is correctly formatted, first open it in Microsoft Excel.

Important: If you don’t import prior depreciation or current depreciation (or both), Fixed 
Asset Manager calculates depreciation for you. If you do import prior or 
current depreciation (or both), then you recalculate depreciation after 
importing, prior and current depreciation amounts may change.
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To import asset data from a CSV format file into a Fixed Asset Manager client 
file:

1 From the File menu, select Import, then select Comma Separated (CSV).
2 Read the instructions in the Welcome page, then click Next.
3 In the Select File page, type the full path for the .csv file that you want or 

click the Browse button to search for the .csv file.
4 Click Next.
5 Select an import template option.

• If you’re importing asset data for the first time or if you want to create a 
new import template from scratch, select Create Template, then click 
Next.

• If you want to use a template that has the same layout (such as the same 
number of columns and the same column order) as the CSV format file, 
select Use Existing Template, then click Finish.

• If you want to modify a template that you created for CSV format files, 
select Edit Existing Template, then click Next.

6 If your client’s CSV file tracks AMT, ACE, Book, State or Other bases and 
you want to import them, select those bases.
Note the following:
• Federal is always selected because you always must classify assets for 

federal depreciation bases.
• You can’t clear the Federal basis selection.

7 When you finish making selections, click Next.
8 Read the instructions in the Column Heading and Row Selection page 

carefully.

Tip: An import template tells Fixed Asset Manager how the data in a file is 
organized. After you set up an import template, you can use it to import other 
files in the same format. Templates are transferred automatically when you 
install a new version of Fixed Asset Manager.

Important: Don’t select the Fixed Asset Manager sample CSV template.

Important: Make sure that you analyze the client file carefully. You’ll want to select only 
the depreciation bases that are in the CSV file and that you want to import. 
You can add other bases to the client file after the data is entered in Fixed 
Asset Manager.
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9 If your client’s CSV file has column headings at the top of the file, select Yes 
under Does your CSV file contain column headings?
When you select this option, you’ll notice that the client data in the first row 
becomes your new column headings. If the column headings begin on a 
different row, specify the row number in the box that appears next to the Yes 
- The headings are on row option.
If the client data begins on a row other than the row indicated in the box for 
the Yes - The headings are on row option, specify the row number in the 
On which row does your asset data begin? box.

10 When you finish making selections, click Next.
11 Read the instructions in the Defining Your Import Template page 

carefully. Map data fields in the CSV format file to corresponding data fields 
in the Fixed Asset Manager client file.
Starting with the first column in the Fixed Asset Manager Fields section, 
click the list box to view the available Fixed Asset Manager fields. Select the 
field to which you want to map the data field in the CSV format file.

Some asset fields in the client’s data may relate to more than one field in 
Fixed Asset Manager. For example, the data may have a field that includes 
information about both Method and Convention, which are two separate 
fields in Fixed Asset Manager. If you need to map data to multiple fields, 
complete step 12 through step 14. Otherwise, go directly to step 15.

12 In the pick list for the column, click <Multiple Fields>.
13 In the Select Multiple Fields page, select the applicable fields for the 

column that you’re mapping.
For example, for Method/Convention, select (Federal) Convention and 
(Federal) Method.

14 When you finish making selections, click OK.
15 Continue mapping the remaining columns to Fixed Asset Manager in the 

Defining Your Import Template page.
If you have a column that can’t be mapped, or a column that you don’t want 
to import, and the column is not a required field for Fixed Asset Manager, 
select Don’t Import.
To learn more about mapping client data to multiple Fixed Asset Manager 
fields, refer to the section titled “Mapping a single CSV field to multiple 
Fixed Asset Manager fields” later in this chapter.

Important: You must make a selection for all Required Fixed Asset Manager fields and 
any other fields that you want to import. Make sure that you examine the 
entire list when making a selection. If you’re not sure how to map fields, refer 
to the section titled “Mapping fields from an export file to Fixed Asset 
Manager” later in this chapter before you continue.
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16 When you finish mapping CSV data to Fixed Asset Manager fields, click 
Next.

17 In the Define Method (Federal) page, go to the (Federal) Method column, 
then click the list box and select the federal method of depreciation for each 
row. Each row in the Method column represents a unique combination of 
data from the CSV file.
If you selected additional bases on the Select Bases page in step 6, Fixed 
Asset Manager displays the Define Method page for each basis that you 
selected.

18 When you finish making selections, click Next.
19 The Define Convention page appears if you mapped the Convention field 

in the Defining Your Import Template page in step 11. Go to the 
Convention section, then click the list box and select the convention for 
each row. Each row represents a unique combination of data from the CSV 
file.

20 When you finish making selections, click Next.
21 In the Finished page, type a name for the import template, click Save, then 

click Finish to begin importing the client’s asset data.
22 When Fixed Asset Manager finishes importing the client’s asset data, review 

the exception log so you are aware of any exceptions that Fixed Asset 
Manager recorded, and carefully review the imported data for accuracy.

Mapping fields from an export file to Fixed Asset Manager
Previous sections of this chapter discussed the steps you need to take during the 
import procedure to map asset fields from an export file created by another 
program into Fixed Asset Manager. This section describes the concept of 
mapping in more detail.

Mapping is the process of correlating asset information from one program to 
another program. For example, you may need to map a data field in an asset 
depreciation program that contains date placed in service information to a similar 
field (such as date acquired) in another depreciation program.

Important: You must map CSV data to all required Fixed Asset Manager fields in the 
import template.

Tip: You can use the import template that you created for other client CSV format 
files that have a similar layout (such as the same number of columns and the 
same column order).
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When importing a client’s asset data into Fixed Asset Manager, first map 
corresponding asset fields from the export file to fields available in Fixed Asset 
Manager. During the import procedure, you’ll create an import template, which is 
a special file containing mapping information that you can reuse to import asset 
data from export files for other clients.

When applying depreciation methods, note that some depreciation programs 
define federal depreciation methods by using asset types (such as Real Property, 
Luxury Automobile, Listed Property, etc.) to define the required method of 
depreciation. Fixed Asset Manager combines statutory asset types that can exist 
as a separate field in other depreciation programs with Fixed Asset Manager’s 
federal depreciation methods.

Fixed Asset Manager calculates the method and convention fields for AMT and 
ACE bases. For ACRS and MACRS assets, Fixed Asset Manager also calculates 
the Section 179 deduction from the federal basis and disables salvage value. 
Fixed Asset Manager selects the appropriate AMT and ACE recovery period if 
they have not been mapped.

You must map fields in each client’s export file to the following five fields in 
Fixed Asset Manager:

● Asset Description
● Date Acquired
● Cost
● Method
● Life

If AMT, ACE, Book, State or Other bases exist in your Fixed Asset Manager 
client file but have not been mapped in your template, Fixed Asset Manager sets 
Date Acquired and Cost for these bases to the federal bases, and sets Method to 
the client template default value.

Date Placed in
Service

Date Acquired
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Mapping field types
You can map three types of fields for a client’s asset data in Fixed Asset 
Manager:

● Fields that can have a one-to-one correspondence and that require data entry 
(such as Asset Description 1, Cost and Life)

● Fields for which the valid entries are included on a pre-defined list (such as 
Method, Convention and Switch to S/L)

● Fields for which the valid entries are included on a list that you define (such 
as Category, Location, Vendor, Amortization Code and User Defined Fields 
1-5)

To translate the various methods or conventions, or to determine whether a 
declining balance method asset switches to straight-line, you may be required to 
map a field (in other words, a column) in the client’s asset data to more than one 
field in Fixed Asset Manager. You may also be required to map a field in the 
client’s asset data more than once.

In Fixed Asset Manager, the Method, Convention, Switch to Straight-Line, and 
Disposition Property Type fields each contain a list of values or items. When you 
map multiple fields in a client’s asset data to these fields, the Import wizard 
creates a list of unique combinations of items in the data consisting of multiple 
fields mapped to one Fixed Asset Manager field. You must select the list item for 
each Fixed Asset Manager field that most closely represents the Method, 
Convention, and so on that is coming from the client’s asset data.

To import your clients’ asset data, use the Fixed Asset Manager Import Wizard. 
For information about how to use the Import wizard, refer to the section titled 
“Importing asset data from Comma Separated Value files” on page 36, or 
“Mapping fields from an export file to Fixed Asset Manager” on page 39.

Important: Fixed Asset Manager allows you to map the ID or the description for the 
following fields:

• Category
• Location
• Vendor/Manufacturer
• Amortization
• User Defined 1 through 5

If you map both the ID and the description in Fixed Asset Manager, only the 
description of the field is imported.
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Mapping examples
As a simple example, assume that you are mapping a Comma Separated Value 
(CSV) data file and that the file was exported from a depreciation program that 
uses an asset field named Date Placed in Service. There isn’t a field named Date 
Placed in Service in Fixed Asset Manager, but there is a field named Date 
Acquired. In this case, you would map the Date Placed In Service field in the 
client’s export file to the Date Acquired field in Fixed Asset Manager.

As you map a client’s data, you may find other asset fields in the client’s export 
file that are correlated (mapped) to Fixed Asset Manager’s asset fields. For 
example:

● Convention
● Asset Type
● Prior Depreciation
● Current Depreciation
● Business Use Percentage
● G/L Asset Account Number
● Vendor/Manufacturer
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A more complicated example is an asset field named Type that identifies the type 
of depreciation treatment prescribed for a given asset. Among the values in the 
Type field in the CSV data file you are importing is a code of RP, which 
identifies a real property asset in the Type field.

In defining your import template, you would map the Type field from the CSV 
format file to the Method field in Fixed Asset Manager. (Note that Method is a 
required field in Fixed Asset Manager.) This mapping would define the Fixed 
Asset Manager federal depreciation method for real property.
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Mapping multiple CSV fields to one Fixed Asset Manager 
field
When you are mapping several fields from a CSV format file to only one field in 
Fixed Asset Manager, you may encounter a situation like the following:

● The CSV format file from which you are importing asset data contains fields 
named Asset Type and Method that identify the federal method for each 
asset in the CSV format file.

You already know that the CSV format file contains the following two ACRS 
depreciable real assets: Personal Tangible Property (TANG) and Real Property 
(REAL).

In this case, you must correctly define the federal depreciation method for each 
of these MACRS assets, because the Asset Type and Method fields in the CSV 
format file do not distinguish between MACRS Personal Tangible Property and 
MACRS Real Property.

If both Personal Tangible Property and Real Property are required to be 
depreciated using the MACRS Straight-line method, you must map the Asset 
Type and Method fields in your CSV data file to Fixed Asset Manager’s 
Method (Federal) field.

Mapping a single CSV field to multiple Fixed Asset 
Manager fields
Let’s assume the depreciation program that the CSV format file was exported 
from uses a field called Method/Convention to define an asset’s federal 
depreciation method and convention. Among the values in the Method/
Convention field in the CSV data file is a code of ADMM. This code identifies 
the federal depreciation method as MACRS Alternate Depreciation System 
(MACRS ADS) and the federal MACRS convention as mid-month.

In defining your import template, you must map the Method/Convention field 
from the CSV format file to the Method and Convention fields in Fixed Asset 
Manager. This defines the Fixed Asset Manager federal depreciation method and 
convention for a MACRS asset being depreciated under the Alternate 
Depreciation System (ADS) using a mid-month convention.

Asset Type

Method

Method

Client File Fixed Asset Manager

Tangible Property
Real Property

Tangible SL
Real SL

MACRS SL
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Tracking depreciation
Depreciation is a method of tracking the decline of an asset’s value for 
accounting and tax purposes. When using depreciation for accounting purposes, 
you can express it as the cost of an asset versus income over a period of time. At 
the end of an asset’s life, the sum of depreciation for previous years equals its 
cost minus any salvage value.

When depreciating assets for tax purposes, you can define depreciation as the 
decline of an item’s market value over the course of its life. Businesses may 
expense a portion of the asset’s cost each year for the use of the asset.

A fixed asset is any piece of equipment or property used by a business that has a 
life of at least one year. It must be in a fully assembled or otherwise usable 
condition and must also be considered an item that is subject to wear and tear.

This chapter shows you how to add assets to your clients file in Fixed Asset 
Manager. It also shows you how to manage assets in Fixed Asset Manager, 
including tracking depreciation, synchronizing with QuickBooks and the sale of 
assets.

Updating assets from QuickBooks
If you have set Fixed Asset Manager synchronization options to manual, you can 
use the Update Assets from QuickBooks selection to bring any changed items 
from QuickBooks into Fixed Asset Manager. You can also use this to force 
synchronization if you have the options set to automatic.

1 From the QuickBooks menu, select Update Assets from QuickBooks.
2 Make your selection for which type of asset you would like to update.
3 Click OK.

You can also designate that synchronization occur automatically when 
opening Fixed Asset Manager. This is the recommended setting.

Important: Synchronization options in Fixed Asset Manager will be disabled if more than 
one version of QuickBooks is running on the same workstation at the same 
time. Close all other versions of QuickBooks that may be open before 
updating assets from QuickBooks.
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Using the Schedule folder to view a client’s assets
When you open a client file, the Schedule folder lists the client’s assets in 
ascending order according to asset number.

You can change the asset list and the columns in the Schedule folder using the 
View Column Set, Sort Assets By and Apply Query Criteria controls on the 
Asset toolbar. For more information on using these tools, refer to Chapter 2, 
“Starting and Setting Up Fixed Asset Manager.”

To view amounts for any basis supported in a client’s file, click the 
corresponding tab at the bottom of the window.

This is the totals line.To view amounts for any basis supported in 
the client’s file, click the applicable tab.

To change the 
column set, asset 
sort set or query 
criteria, use the 
Asset toolbar.

Use the mouse to 
resize columns and 
to drag and drop a 
column in a 
different position.

Tip: If an asset doesn’t appear in the Schedule folder, check the query selection on 
the Asset toolbar. If the asset falls outside the current query, it won’t appear in 
the Schedule folder.

Tip: The Total line shows the accumulated values of each numerical column. You 
can leave the total line at the bottom of the asset list or you can lock it in place 
at the bottom of the screen. For more information about this option, refer to 
Chapter 2, “Starting and Setting Up Fixed Asset Manager.”
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If you want to increase or decrease the magnification of the contents of the 
Schedule folder, go to the View menu, select Magnify, then select the 
magnification percentage that you want. (The default selection is 100%.) The 
percentage you select remains in effect until you select a different percentage.

To change the column width so all columns appear in the Schedule folder without 
scrolling, go to the View menu and select Resize all columns.

Disposing multiple assets at once
Fixed Asset Manager allows you to dispose of more than one asset at one time. 
To do this, you’ll use the Fixed Asset Manager Dispose Multiple Assets wizard:

1 Select the assets you want to dispose of in the Schedule folder. Use the Ctrl 
key on the keyboard and the left mouse button to select the assets.

2 From the Asset menu, select Dispose Assets.
3 In the Dispose Multiple Assets window, enter the Disposition date for all 

assets being disposed. Fixed Asset Manager uses the last day of the client 
year as the default. Enter the complete month, day and year of the 
disposition. This date affects the amount of depreciation calculated for the 
current year and how the gain is treated on the client’s tax return.
Also, enter a Sale Description for all assets using up to 50 letters or 
numbers. You do not have to choose a unique description. Fixed Asset 
Manager reminds you if the Sales Description has been used before in the 
client file. When you are finished with your entries, click Next.

4 Use the Property Type window to indicate where the information for this 
disposal should print on the Form 4797 Tax Worksheets and where it should 
be reported on Form 4797, Sales of Property in the ProSeries Tax client. 
Click Next.

5 Use the Allocation Method for Disposition Amounts window to select 
either Use the same amounts for all assets or Allocation amounts using 
the basis (Federal, AMT, ACE, Book, State, Other) and either Cost or 
Remaining Basis, then click Next.

6 In the following series of wizard screens, enter the amount in the Total for 
all assets box. You’ll notice that Fixed Asset Manager automatically 
allocates the percent and amount to each asset for each of these wizard 
screens:
• Allocate Sales Price
• Allocate Sales Expense
• Allocate ITC Taken
• Allocate Disposition Basis
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Make sure you enter the total amount for all assets, then if necessary, modify 
the percent or amount to allocate to individual assets. You must allocate 
100% of the total. As you change the amount or percent for individual assets, 
any unallocated amount is reflected in the “Unallocated:” line. The 
“Unallocated” amount can be allocated evenly between all assets by entering 
0.00 in the “Unallocated:” line.

7 In the Summary page, a summary table of the assets that you selected to 
dispose appears. Review the table carefully. You can use your mouse to 
resize any columns of information that are too narrow. Click Back if you 
want to go back and edit a selection, otherwise, click Finish.

Splitting an asset into two or more assets
You can create two or more assets from one existing asset in Fixed Asset 
Manager. When you dispose of an asset, you may have a need to perform a 
partial disposition where you must first divide the asset into two or more new 
assets, then dispose of one or more of the new assets.

To split an asset, select the asset in the Schedule folder, then go to the Asset 
menu and select Split Asset.

In the Split Asset window, you’ll select the number of new assets you want to 
create, then adjust the amounts or percentages for each asset. If you want to 
allocate amounts evenly, enter 0.00 in the Unallocated field.

When you click OK, Fixed Asset Manager copies the fields that are entered on 
the Asset and Basis detail panes to the new assets. There is an exception for the 
dollar amounts that are allocated to each asset using the percentage you assign to 
the asset in the Percent column.

Tip: If you want to remove all disposition information from selected assets in the 
Schedule folder, select Undispose Assets from the Asset menu.

Enter 0.00 in 
Unallocated to 
allocate amounts to all 
assets equally
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The fields that are allocated using the percentages you specify are:

● Cost or basis
● Section 179 deduction
● Special Depreciation Allowance
● ITC basis reduction
● Other deductions
● Salvage value
● Prior depreciation

Changing multiple groupings and accounts
Use the Assign Grouping to Asset... and the Assign G/L Accounts to Assets...  
commands on the Asset menu to set the Groupings and Accounts for a number of 
assets at once. You’ll select the assets you want to modify in the Schedule folder.

To change groupings:

1 While in the Schedule folder, select the assets you would like to group.
2 From the Asset menu, select Assign Groups to Assets.
3 You can select one or multiple groupings to assign to the assets.
4 Click OK.

To change accounts:

1 Select the assets to which you would like to apply an account 
2 From the Asset menu, select Assign G/L Assets to Accounts. 
3 Assign an Asset Account, Depreciation/Amortization Account and 

Depreciation/Amortization Expense accounts. 
4 Click OK. 

Changing the Tax Form link for multiple assets
You can change the tax form link for several assets at once which can save you a 
lot of time if you use the Tax Worksheets or export assets to ProSeries, or both.

Important: This powerful feature enables you to modify asset information in any or all 
assets at one time. If you are modifying a large number of assets at once, you 
may want to back up the client file before proceeding.
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To change a form link:

1 Select the assets you want to change in the Schedule folder.
2 From the Asset menu, select Apply Form Link.
3 In the Apply Form Link to selected asset(s) window, select a form in the 

Choose a form to apply to the selected asset(s) list.
If you want to remove a Form Link from all the assets you have selected, 
select Not Linked.

4 Click OK.

The Apply Form Link option is only available when you are in the Schedule 
folder and you have selected one or more assets.

Setting the property name
If the form you select is a multiple-copy form, you can also set the property name 
in the assets that you selected in the Schedule folder.

When you click OK, Fixed Asset Manager applies the Form Link and Property 
Name to the selected assets. If the Schedule is sorted or filtered using either the 
Form Link or Property Name, the assets you selected can appear in a different 
position in the Schedule, or may not appear in the Schedule at all.

Adding an asset to a client file
To add an asset:

1 Go to the Asset menu and select Add Asset.
Fixed Asset Manager opens the Asset folder (if it isn’t already open).

If you want to do this Do this

Change the Form Link but do not 
want to change the property name

Choose (Do not modify) from the 
Property Name box

Remove the existing property 
name from the selected assets

Choose (No Entry) from the Property 
Name box

Add a property name to the list Click the Add a Property Name button

Change the property name for all 
the assets selected in the Schedule 
without changing the form link

Use the Apply Groupings and 
Accounts wizard or change the Form 
Link and the Property Name
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2 Enter general information about the asset in the Asset Detail (upper) section 
of the Asset folder, using the Tab key or the mouse to move from field to 
field.

You must include an asset number for the asset. While not required, you 
should enter an asset description here, also.

3 Click the Basis Detail (lower) section of the Asset folder, then enter all 
relevant basis information for the asset.
In the Basis Detail section of the Asset folder, you make decisions about the 
active asset for each supported basis. Current-year depreciation and 
remaining basis appear at the bottom of this section of the Asset folder. For a 
description of each field in the Asset folder, refer to the section titled 
“Entering asset information in the Asset folder” later in this chapter.

4 When you finish entering information about the asset, go to the File menu 
and select Save.

Editing asset information in a client file
To edit the information:

1 Go to the Schedule folder.
2 Select the line for the asset in the Schedule folder, then click the Asset tab to 

open the Asset folder.

3 Click the first field that you want to edit, then correct the information.
4 Repeat this process for each additional field that you want to edit.

Tip: To move from field to field within a section, press Tab or Enter to move 
forward, and press Shift+Tab to move back.

Tip: Use the Alt+3 keyboard shortcut to move from the Asset Detail section to the 
Basis Detail section. Use the Alt+2 keyboard shortcut to move from the Basis 
Detail section to the Asset Detail section.

Tip: You record the sale of assets in the Disposal folder and add preparation notes 
in the Notes folder.

Tip: Double-click the line for the asset in the Schedule folder to open the Asset 
folder quickly.
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5 When you finish editing the information for the asset, go to the File menu 
and select Save.

Saving assets to QuickBooks
Use this method to transfer and update any changed asset items from Fixed Asset 
Manager to the Fixed Asset Item list in QuickBooks. If the Fixed Asset Manager 
synchronization options are set to Manual, you must use this method to update 
any asset items from Fixed Asset Manager to QuickBooks. You can also use this 
method to force synchronization if you have the synchronization options set to 
perform automatically.

1 From the QuickBooks menu, select Save Assets to QuickBooks. If this 
selection is unavailable (grayed out), you need to assign accounts to the 
selected asset.

2 Make your selection for the type of asset you want to update.
3 Click OK.

Entering asset information in the Asset folder
To work in the Asset folder, click the Asset tab below the toolbar.

Entering general information
Use the Asset Detail (upper) section of the Asset folder to enter general 
information for the active asset, including any classification fields.

Important: Synchronization options in Fixed Asset Manager will be disabled if more than 
one version of QuickBooks is running on the same workstation at the same 
time. Close all other versions of QuickBooks that may be open before 
updating assets from QuickBooks.
Entering and Managing Asset Information 53



The following table describes each field in the Asset Detail section of the Asset 
folder:

This is the Asset 
Detail section of 
the Asset folder.

Click here then 
drag to adjust the 
size of the top and 
bottom sections.

Use these scrollbars to move up and down within each section.

Field Description

Asset number Any unique combination of up to ten letters and numbers. By default, the next sequential 
number appears. You can accept this value or change it.

Asset description 
(lines 1 and 2)

You can use up to 50 letters, numbers and spaces on each line to describe the asset. 
Because the asset description is frequently used on reports, you may want to use a short 
report name on line 1 and a more detailed reference name on line 2.

Purchase order 
number

If a purchase order was used for this asset, enter it here for reporting purposes and to 
cross-reference it with accounts payable.

Warranty expires Enter the termination date of any warranties associated with this asset. Use this 
information when you print identification labels and as a quick reference.

Serial number Enter the serial number of the asset. You can use this information as a quick reference if 
service is needed, and as a cross-reference with inventory.
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Entering basis information
Enter the cost, date acquired and other information used to calculate an asset’s 
current depreciation in the Basis Detail section of the Asset folder. This section 
describes each field in the Basis Detail section.

Personal 
property return?

If this is a personal property return, you can see the active asset on the Personal 
Property Schedule by Year Acquired report by selecting this check box.

New? Indicate whether the asset was purchased new or used.

Link to Federal 
Form

If you are using the tax worksheets or ProSeries products to prepare a client’s tax return 
and you want to link an asset to a particular form in the return, you can do so here. If you 
import assets from other fixed asset management programs, or create new assets for non-
1040 clients, Fixed Asset Manager sets the form link to the main activity automatically.

If the form you select maintains separate properties, you can indicate the property name. 
Enter the name exactly as it appears on all multiple-copy forms, e.g. Schedule E 
worksheet, Schedule C, Schedule F, Form 2106, Form 4835, Schedule K-1 Worksheet 
(Partnership), Form 8825 Worksheet, Form 8825 Rental Real Estate Income and 
Expenses of a Partnership or an S Corporation.

General Ledger 
Accounts

For reporting purposes, assign accounts from the client’s general ledger to the asset here. 
For each asset, you can track an Asset account, an Accumulated Depreciation/
Amortization account and a Depreciation/Amortization Expense account.

Enter the account numbers or choose from the list if you’ve already created a list of 
accounts. Each time you enter a unique account number, that number is added to the 
account list for future use.

Category Use groupings to organize the asset list in reports. Enter the grouping to which an asset 
belongs, or choose one from the list.

Location If the client maintains assets at several offices, use the Location field to sort assets by 
office.

Vendor/mfg. Use the vendor to organize and sort assets by vendor. Enter the vendor or choose a 
vendor from the list.

Amortization/
IRC Section

Enter the Internal Revenue Code section number, Treasury regulation or appropriate state 
law on this line.

User defined 
fields 1-5

User-defined fields allow you to create specialized groupings or sub-categories for the 
assets. You can use these groupings for sorting and reporting. Enter a value for each user-
defined field.

Field Description
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Entering the date placed in service
Enter the date the client began using the asset for business purposes. This is 
usually the asset’s date of purchase.

Entering the cost or basis
Enter the value of the asset when it was placed in service.

Entering the tax system
Enter the applicable tax system. By default, the program makes one of the 
following selections, based on the date placed in service:

● Other, for dates prior to 1/1/81

Tip: You can resize the basis detail section of the Asset folder and change font size. 
For more information about changing font size, refer to Chapter 2, “Starting 
and Setting Up Fixed Asset Manager.”

You can enter a four-digit or a two-digit year in the date fields.

This is the Basis 
Detail section of the 
Asset folder. Use the 
Tab key or your 
mouse to move from 
field to field, and the 
arrow keys to move 
from column to 
column.

Tip: When entering dates, you can enter a four-digit or a two-digit year.
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● ACRS, for dates between 1/1/81 and 12/31/86
● MACRS, for dates after 1/1/87
● Amortization, for intangible assets
● Section 168(f)(1), for assets depreciated on a units-of-production basis

Entering the depreciation method
Review the list of choices for the active tax system and make a selection 
according to the asset type. 

Selecting an asset’s recovery period
The asset’s recovery period is the amount of time over which depreciation may 
be deducted.

Enter the appropriate life of this asset for each basis. The format of this field is 
yy/mm. For example, an asset with a life of twenty-seven-and-one-half years is 
27/06.

Based on the asset’s tax system and method, an appropriate default appears.

Use the class life tables established by IRS code (Publication 946, Appendix B) 
to select from one of eight recovery periods for MACRS assets. The tables assign 
a GDS class life (used by MACRS) and an ADS class life (used with ACE, AMT 
and for 150% MACRS assets placed in service before 1/1/99). Assigned MACRS 
property classes are 3, 5, 7, 10, 15 and 20-year property; water utility property; 
residential rental property; non-residential real property; railroad gradings or 
tunnel bores; and qualified Indian reservation property.

ACRS assets are assigned a recovery class that determines the recovery period or 
life, for the asset. Allowed recovery periods for ACRS assets are 3, 5, 10, 15, 18 
and 19 years. Alternative recovery periods are available with alternative methods 
or listed property.

For assets placed in service before MACRS or assets that do not qualify for 
MACRS, you must determine the asset’s useful life. Useful life is an estimate of 
how long your client expects to use the item in trade or business.

Selecting the averaging convention
A convention applies for each asset based on the date acquired and the method 
used. The averaging convention you select affects the depreciation calculated for 
the first year the asset is placed in service and the year of its disposition or the 
final year of depreciation.

Important: Fixed Asset Manager does not currently support qualified Indian reservation 
property. 
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To change this value, click the down arrow to see the list of choices, then make a 
selection.

The averaging conventions are:

● Half-Year — Treats property as placed in service or disposed of at the mid-
point of the year. This convention applies to all MACRS personal property 
unless more than 40% of the total depreciable basis of all personal property 
assets were placed in service in the last three months of the year. When this 
limit is exceeded, Fixed Asset Manager uses the MACRS mid-quarter 
convention (see below).

● Mid-Quarter — Treats property as placed in service at the mid-point of the 
quarter. This convention applies when 40% of the total depreciable basis of 
all personal property were placed into service in the last three months of the 
year. To determine whether you need to use the mid-quarter convention:

- Go to the Tools menu and select 179/40% Test.
- In the Section 179/40% Text window, click the 40% Test tab.
- Review the information, then click OK.

● Mid-Month — Treats MACRS real property as placed in service or 
disposed of at the mid-point of the month.

● Act-Days (Actual Days) — Applies depreciation for the actual number of 
days the asset was in service for the year of purchase and the year of 
disposition.

● APL-ACRS — Used for personal property, this option allows a full year of 
depreciation when the asset is first placed in service, and no depreciation in 
the year of disposition. Real property is depreciated based on the month 
placed in service, and a pro-rated amount is allowed in the year of 
disposition.

● Full-Month — Depreciates all assets as if they were purchased or disposed 
of on the first of the month.

● Half-Month — Treats assets placed in service in the first half of the month 
or disposed of in the second half of the month as being in service for the 
entire month. Assets placed in service in the second half of the month or 
disposed of in the first half of the month are treated as not being in service 
for the entire month.

Entering Section 179 deductions
Enter the amount of the Section 179 deduction to be taken in the current year or 
the amount that has been taken in the prior year for this asset.

Section 179 of the Internal Revenue Code permits certain taxpayers to deduct all 
or part of the cost of qualifying property in the year they placed it in service, 
instead of depreciating the basis over a specified recovery period. There are 
limits to the amount that can be deducted in a tax year. These limits include a 
total dollar limit, an investment business cost limit and an income limit.
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The following list describes property that qualifies for the Section 179 deduction:

● Tangible personal property
● Other tangible property (except most buildings and their structural 

components) used in one of the following ways:
- As an integral part of manufacturing, production or extraction; or to 

furnish transportation, communications, electricity, gas, water or 
sewage disposal services

- As a research facility related to any of the activities listed above
- As a facility for the bulk storage of tangible commodities from any of 

the activities listed above
● Single-purpose agricultural (livestock) or horticultural structures
● Storage facilities (except buildings and their structural components) used in 

distributing petroleum or any primary product of petroleum

You cannot claim the Section 179 deduction on the following types of properties:

● Property held only for the production of income (rental property)
● Real property, including buildings and their structural components
● Property that is acquired by one member of a controlled group from another 

member of the same group
● Property whose basis is either of the following conditions:

- Determined in whole or in part by its adjusted basis in the hands of the 
person from whom you acquired it

- Determined under stepped-up basis rules for property acquired from a 
decedent

● Property that is acquired from a related person
● Tangible personal property used in connection with residential real estate

Observing Section 179 limits
Refer to the IRS website (www.irs.gov) for this year’s details about:

Dollar limit — The maximum annual business cost you can deduct under Section 
179. The limit applies to each taxpayer, not to each business. You may expense 
the entire basis of an asset up to the dollar limitations, or expense a portion of 
several assets and depreciate any remaining cost.

Gulf Opportunity Zone — The maximum annual business cost that companies 
with property in the Gulf Opportunity Zone can deduct.

Important: Fixed Asset Manager does not support excluding tangible personal property 
associated with residential rental activity from the calculation of the 
investment cost limit. You must subtract any such assets from the investment 
business cost limit calculated by Fixed Asset Manager.
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Investment business cost limit, including the investment business cost limit for 
property in the Gulf Opportunity Zone.

Taxable Income limit — The Section 179 deduction that can be taken in a given 
tax year is limited to the taxable income generated for that year:

● An individual’s taxable income is figured by determining the net income 
from all trades and businesses that the taxpayer and the taxpayer’s spouse 
(when married filing jointly) conducted during the tax year. This includes 
Section 1231 gains (or losses), interest from working capital of the trade or 
business, and wages, salaries, tips or other compensation earned as an 
employee. Any disallowed cost can be carried over to the next tax year.

● The Section 179 deduction applies to both the partnership and each partner. 
The partnership determines its Section 179 deduction and allocates the 
deduction among its partners. Each partner adds the amount allocated from 
the partnership to his or her other Section 179 costs and then applies the 
maximum dollar limit to this total to determine his or her Section 179 
deduction. The investment business cost limits of individual partners are not 
affected by partnership property placed in service. The total amount of each 
partner’s Section 179 deduction is subject to both the taxable income limit, 
the maximum dollar limit and the investment business cost limits on 
nonpartnership property.

● The rules that apply to a partnership and its partners also apply to an 
S corporation and its shareholders. The limits apply to an S corporation and 
to each shareholder. The corporation allocates the deduction to the 
shareholders, who then take their Section 179 deduction subject to the 
limitations.

For luxury automobiles, the limitation is the luxury automobile limitation for the 
year. The deduction is not allowed if an asset’s business-use percentage is 50% or 
less. The depreciable basis of the asset is reduced by the amount of the deduction 
taken.

The deduction on the book, state and other basis is not included in any 
calculations for those bases.

Entering the special depreciation allowance
Enter the special depreciation allowance for qualified property placed in service 
after September 10, 2001.

Rules for taking the Special Depreciation Allowance
The Job Creation and Worker Assistance Act of 2002 provided for a 30% Special 
Depreciation Allowance for certain property placed in service after September 
10, 2001. The Jobs and Growth Tax Relief Reconciliation Act of 2003 increased 
the Special Depreciation Allowance to 50% and increased the Luxury Auto limits 
for Passenger Automobiles and Clean Fuel Vehicles. Revenue Procedure 2003-
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75 added new luxury auto limits for Trucks and Vans. See IRS Form 4562 
Instructions for further guidance.

Property Qualified for the Special Depreciation Allowance after September 
10, 2001:

1. Property qualifying for the Special Depreciation Allowance must be:
(a) Tangible property to which the general rules of MACRS apply that
(b) has an applicable recovery period of 20 years or less, or
(c) is certain water utility property, or
(d) is qualified leasehold improvement property, and any other 

property that is also qualified New York Liberty Zone property.
(e) Computer software other than computer software covered by IRC 

section 197, or
(f) “Original Use” property which means that original use of the asset 

must commence with the taxpayer on or after September 11, 2001 
where:
i. The property must be acquired after September 10, 

2001. If a binding contract to acquire the property 
existed before September 11, 2001, the property does 
not qualify.

There are special rules for sold and leased back and for self-constructed 
property.

2. The following types of property generally have a MACRS GDS 
recovery period of 20 years or less:
(a) Computers
(b) Video, photo, phonographic equipment
(c) Cellular phones
(d) Office equipment
(e) Office furniture, farm equipment
(f) Rental furnishings
(g) Tools, equipment
(h) Land improvements
(i) Software
(j) Auto, light truck, van under 6,000 lbs
(k) Light truck, van over 6,000 lbs
(l) Heavy truck, over 13,000 lbs
(m) Truck tractor for over-the-road use
(n) Rent to own property
(o) Property used in distributive trades and services
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3. Intangible property that is amortizable under IRC section 197 is not 
property qualified for the Special Depreciation Allowance.

4. Residential rental property and nonresidential real property generally do 
not qualify for the Special Depreciation Allowance, except for:
(a) certain nonresidential qualified leasehold improvements, and
(b) certain residential rental and nonresidential real property placed in 

service within the Liberty Zone.
Exceptions:
• Residential rental property: New York Liberty Zone residential 

rental property is qualified property to the extent it replaces 
property destroyed or condemned as a result of the terrorist attacks 
of September 11, 2001.

• Nonresidential real property: Leasehold improvements may be 
qualifying property. The leasehold improvement must (1) be placed 
in service more than three years after the building was placed in 
service, and (2) not be a qualified New York Liberty Zone leasehold 
improvement property.

5. New York Liberty Zone nonresidential property is qualified property to 
the extent that it replaces property destroyed or condemned as a result of 
the terrorist attacks of September 11, 2001 and is not a qualified New 
York Liberty Zone leasehold improvement.

Qualified property does not include:

• Listed property used 50% or less for business
• Any property required to be depreciated under the Alternative 

Depreciation System (ADS), and
• Qualified New York Liberty Zone leasehold improvement property

Qualified New York Liberty Zone leasehold improvement property
Qualified New York Liberty Zone leasehold improvement property is not eligible 
for the Special Depreciation Allowance. Instead, Qualified New York Liberty 
Zone leasehold improvement property is depreciated as 5-year property using the 
straight-line method. A 9-year period is used for purposes of the Alternative 
Depreciation System (ADS).

Luxury Auto Limits for Qualified Trucks and Vans, Passenger Autos, and 
Electric Vehicles placed in service after September 10, 2001
Qualifying vehicles subject to luxury automobile depreciation limits are eligible 
for a larger deduction. An election out of the special depreciation allowance 
disqualifies a vehicle from the higher first year luxury auto limits.

Total first year deduction limits:
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1. For vehicles qualifying for the 30% special depreciation allowance that 
are placed in service from 9/11/2001 through 12/31/2001, the first year 
deduction limit is:
(a) Passenger autos - $7,660
(b) Electric vehicles - $23,080

2. For vehicles qualifying for the 30% special depreciation allowance that 
are placed in service from 01/01/2002 through 12/31/2002, the first year 
deduction limit is:
(a) Passenger autos - $7,660
(b) Electric vehicles - $22,980

3. For vehicles qualifying for the 30% special depreciation allowance that 
are placed in service from 01/01/2003 through 12/31/2003, the first year 
deduction limit is:
(a) Passenger autos - $7,660
(b) Trucks and Vans - $7,960
(c) Electric vehicles - $22,880

4. For vehicles qualifying for the 50% special depreciation allowance that 
are placed in service from 05/06/2003 through 12/31/2003, the first year 
deduction limit is:
(a) Passenger autos - $10,710
(b) Trucks and Vans - $11,010
(c) Electric vehicles - $32,030

5. For vehicles qualifying for the 50% special depreciation allowance 
(even if electing 30%) that are placed in service from 01/01/2004 
through 12/31/2005, the first year deduction limit is:
(a) Passenger autos - $10,610
(b) Trucks and Vans - $10,910
(c) Electric vehicles - $31,830

6. For vehicles qualifying for the 30% special depreciation allowance that 
are placed in service from 01/01/2004 through 12/31/2005, the first year 
deduction limit is:
(a) Passenger autos - $7,560
(b) Trucks and Vans - $7,860
(c) Electric vehicles - $22,680

How the Fixed Asset Manager program handles Special Depreciation 
Allowance
The Fixed Asset Manager program enters 30% or 50% (depending on the box 
that is checked) of the cost or other basis (reduced first by any reduction in 
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Business Use Percentage, Section 179 Deduction, Other deductions, Salvage 
Value, and ITC basis reduction taken on the asset) when:

• You have not cleared the New? check box on the Asset Detail pane in the 
Asset folder, thus indicating that “Original Use” started after September 
10, 2001,

• The date entered in Date placed in service is after September 10, 2001, 
• The Tax system and Depreciation method you selected indicates that the 

asset may qualify for the Special Depreciation Allowance, and
• You have selected the Qualified for Special Depr. Allowance (30% or 

50%) check boxes on the Basis Detail pane, enabling the Special 
Depreciation Allowance.

“Electing out” of the Special Depreciation Allowance
If you want to elect out of this special allowance, do not select Qualified for 
Special Depr. Allowance (30% or 50%) check boxes on the Basis Detail pane 
enabling the Special Depreciation Allowance calculations.

You may elect, with respect to any whole class of property, not to have the 
Special Depreciation Allowance apply for all property in such class placed in 
service during the tax year. To make the election, attach a statement to the tax 
return indicating the class(es) of property for which you are electing to not claim 
the Special Depreciation Allowance.

No AMT Adjustment for Qualified Property
If an asset does not have an AMT cost basis that is different from its federal cost 
basis, there is no Alternative Minimum Tax (AMT) adjustment for property 
qualified for the Special Depreciation Allowance, thus eliminating the AMT 
adjustment for MACRS 200% declining balance property.

Electing 30% in place of 50% Special Depreciation Allowance
The law allows you to compute the special depreciation allowance using the 30% 
rate for assets placed in service after May 5, 2003, even if the property qualifies 
for the 50% rate. The election is made separately for each class of property that 
qualifies for the 50% allowance. To make this election, check the 30% box and 
the 50% box. When both boxes are checked, the program calculates up to a 
$7,650 larger deduction for qualifying vehicles subject to the luxury automobile 
limitation, and up to a $22,950 larger deduction for qualifying electric passenger 
automobiles.

To make this election, check both the 30% and the 50% Qualifying property 
boxes. You must also prepare an election statement and attach it to the client’s tax 
return.
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Exporting to ProSeries
When you are exporting asset data to ProSeries tax preparation software, 
remember that:

• When exporting client data to the ProSeries program, the Special 
Depreciation Allowance calculation is included in the export.

• When “Qualified Property” is marked either 50% or 30%, the program 
automatically answers the “Elect OUT” question as No to indicate that 
you want to take the deduction, and that you are not making the election 
to exclude this class of property from the Special Depreciation 
Allowance.

• When “Qualified Property” is marked 50%, the program automatically 
answers the “Elect 30%” question as No.

• When “Qualified Property” is marked 30% and 50% (when electing to use 
30% in place of 50% Special Depreciation Allowance for assets placed in 
service after May 5, 2003), the program automatically answers the “Elect 
30%” as Yes to indicate that you are electing to use the 30% rate even 
though the property qualifies for the 50% rate.

Entering other deductions
Enter any additional deductions required for this asset. Amounts entered here 
reduce the basis for depreciation.

Entering the salvage value
Enter the asset’s salvage value. This is the value your client expects to receive 
when the asset is sold at the end of its useful life. This value is used to reduce the 
cost of an asset for the purposes of determining depreciation for book, state or 
other basis. The program does not accept a negative number.

Entering the ITC basis reduction
Enter the amount of Investment Tax Credit (ITC) basis reduction taken. This 
amount is used when calculating gain or loss on the disposition of an asset.

Entering the business-use percentage
Enter the percentage of time the active asset is used for business purposes. Fixed 
Asset Manager uses this amount to determine the maximum allowable 
depreciation.

Calculating accumulated depreciation as of 01/01/90
To calculate ACE depreciation for the active asset, enter the accumulated 
depreciation as of the first tax year beginning after 1989. For ACRS assets, enter 
the federal amount. For MACRS assets, enter the AMT amount.
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Using a Non-MACRS preference code
The Non-MACRS preference code is part of the calculation for the yearly Non-
MACRS Alternative Minimum Tax preference amount. View the list of choices 
for this field and make a selection.

Using the switch to straight-line option
Use the switch to straight-line option to maximize current and future depreciation 
for the assets under the tax systems Book, State and Other, and with Non-
MACRS assets. When you select this item, Fixed Asset Manager automatically 
switches the depreciation method when straight-line generates more 
depreciation. Clear the check box to make this determination manually.

Entering prior depreciation
Enter the depreciation taken for prior years. Fixed Asset Manager automatically 
updates this amount when you close the year.

Current depreciation
The Current Depreciation field shows depreciation for the current year 
calculated by Fixed Asset Manager.

Accumulated depreciation
The Accumulated Depreciation field shows the sum of prior and current 
depreciation calculated by Fixed Asset Manager. You cannot modify this 
summary amount.

Unrecovered basis
The Unrecovered Basis field shows the difference when Fixed Asset Manager 
deducts the prior depreciation from the cost/basis of the asset.

Entering the IRC Section 754 status
If the client’s form type is 1065, you may select this option to indicate that this 
asset qualifies under IRC Section 754.

Entering the AMT status
1120 Clients only — Select this option to indicate that this asset is subject to 
AMT. If the client’s small corporation status is “No Longer Qualified,” this check 
box is empty. Select this option to make the AMT column of the basis screen 
available.

Entering the ACE status
1120 Clients only — Select this option to indicate that this asset is subject to 
ACE. If the client’s small corporation status is “No Longer Qualified,” this check 
box is empty. Select this option to make the ACE column of the basis screen 
available.
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Calculating assets
To calculate depreciation calculations for the current asset, go to the Asset menu 
and select Calculate Asset. 

You can set Fixed Asset Manager to automatically calculate assets after making 
modifications using the Program Options window. To select this setting, go to the 
Tools menu and select Program Options. Select the General tab, then select the 
Automatically Calculate Assets option so that a check mark appears in the 
check box. Click OK to save the change.

Recalculating prior depreciation
To calculate prior depreciation for the current asset, go to the Asset menu and 
select Recalculate Prior Depreciation. 

Posting the journal entry to QuickBooks
Fixed Asset Manager automates the process of creating a journal entry for 
depreciation expense and/or accumulated depreciation.

1 From the QuickBooks menu, select Post Journal Entry to QuickBooks. 
2 When the Post to QuickBooks General Journal window opens, 

Depreciation Expense and Accumulated Depreciation accounts that have 
been used in the asset entry window appear.

3 Enter a Depreciation through date.
4 The default journal entry number defaults to “FAM” which helps identify the 

entries originated from Fixed Asset Manager. However, this journal entry 
number can be changed to whatever fits your needs.

5 Enter your debit and credit amounts, and designate the basis to post.
6 Select the Add Entry Line button if you need to add additional entry lines to 

the journal entry. 
7 When the information is complete, select the Post Entry to QuickBooks 

button.

Important: After completing the journal entry, you can view a log of the journal entry 
made. From the View menu, select Logs, then select Journal Entry Log.
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Displaying the journal entry list
You can access a log of the journal entries made to QuickBooks from Fixed Asset 
Manager by accessing the QuickBooks menu and then selecting Display 
Journal Entry List.

Using the Disposal folder to record asset dispositions
An asset is disposed of when it is sold, abandoned or traded for another asset. For 
tax purposes, you must discontinue depreciation calculations for a disposed of 
asset and determine whether the client sustained a gain or loss from the 
disposition. Enter information about the disposition of an asset in the Disposal 
folder.

To record the disposal of an asset:

1 Select the asset for which you are entering disposition information.
2 Click the Disposal tab.
3 In the General Disposition Information section, click the Yes check box 

for the “Has this asset been disposed?” option.
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4 Enter a description for the asset sale, using up to 50 letters and numbers or 
select a description that you previously entered.
To see a list of the descriptions that you previously entered, select this field, 
then click the down arrow that appears to the right of the field.

5 Select a property type from the list.
The property type you choose determines where the disposal information 
appears on Form 4797, Sales of Business Property, when you import 
information from the Fixed Asset Manager client file into a ProSeries client 
file.
To see the list of property types, select this field, then click the down arrow 
that appears to the right of the field.

6 Use the Tab key or your mouse to select the Date of disposition field in the 
Federal column of the Basis Disposition Information section.

7 Enter the month, day and year of the disposition. This date affects the 
amount of depreciation calculated for the current year and how the gain or 
loss is treated in the client’s tax return.
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8 Enter information in the fields that are described in the following table:

Field Description

Sale price Enter the actual sales price or the fair market value of all property or services 
received prior to deducting any expenses of the sale or disposal. Adjusted basis is 
subtracted from this amount to determine the gain or loss. 

Expense of sale Enter any costs of sales or disposal. Such costs can include advertising, commissions 
or delivery. This amount is added to the cost or basis to determine the adjusted basis. 
You cannot enter a negative amount.

ITC Taken Enter the ITC and other credits that affect the sale of the asset. This amount is for 
informational purposes only.

Cost or basis The initial cost or basis appears for the asset. You cannot adjust this amount in the 
Disposal folder.

Section 179 
deduction

This is any Section 179 deduction taken for the asset. You cannot adjust this amount 
in the Disposal folder.

Special Depr. 
Allowance

This is any Special Depreciation Allowance taken for this asset. You cannot adjust 
this amount in the Disposal folder.

Disposition basis Enter a separate regular and AMT basis for assets acquired in a trade if, while in 
service, the business-use percentage for the disposed of asset was less than 100%. 
You must adjust the basis of such an asset by reducing it by the prior depreciation 
constituting the personal use portion. Enter the total recomputed regular and AMT 
basis for disposition purposes.

Depreciation after 
1975

For Section 1250 property, enter any additional depreciation taken after 1975 to 
compute the recapture amount. For MACRS residential and nonresidential real 
property and other section 1250 property depreciated on a straight-line method, there 
is no additional depreciation.

Applicable 
percentage

Enter “100” for Section 1250 property that is not low-income rental housing. To 
determine the applicable percentage for low-income rental housing, see the IRS 
instructions for Form 4797, Part III.

Depreciation after 
1969 and before 
1976

For Section 1250 property, enter additional depreciation taken after 1969 and before 
1976. You may reduce this amount of recapture by the amount, if any, that straight-
line depreciation after 1975 exceeded actual depreciation taken after 1975.
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9 Review the Fixed Asset Manager calculations in the fields that are described 
in the following table. When you finish entering disposal information, go to 
the File menu and select Save.

Using the Notes folder to attach preparation notes
The Notes folder contains a basic word processor that allows you to make 
preparation notes about the active asset. When a note is present for a selected 
asset, the word “Note” appears in black on the status bar. When a note is not 
present for a selected asset, the word “Note” appears dimmed on the status bar.

To add or edit notes for the active asset, click the Notes folder.

Use the Cut, Copy and Paste options on the Edit menu to move text or to copy 
information from other folders. To insert the current date and time into the Note, 
move your cursor to the appropriate place in the note and press the F5 key.

Field Description

Accumulated 
depreciation

Fixed Asset Manager calculates accumulated depreciation as current depreciation 
through the date of disposal plus any prior depreciation. This amount is subtracted 
from the cost or basis to determine the adjusted basis.

Unrecovered basis Fixed Asset Manager calculates adjusted basis as:

(Cost or Basis + Sales or Disposal Expense)
- ITC basis reduction
- Other deductions
- Accumulated depreciation

The program uses the adjusted basis in determining the gain or loss.

Gain/loss on sale Fixed Asset Manager calculates a gain or loss as Gross Sales Price - Adjusted Basis.

Form 4797 gain/loss 
(excluding Sec. 179)

This field is only visible for 1065 and 1120S clients. It shows the Gain/loss on a sale 
with the Section 179 deduction excluded.

Important: For 1065 and 1120S returns, the gain or loss reported should not include the 
Section 179 expense deduction because shareholders and partners are required 
to separately report any recapture of the deduction taken on their individual 
return. Instead, you must report the full gain or loss in the appropriate part of 
Form 4797 and separately report the Section 179 expense deduction on 
Schedule K.

Tip: You can also use text editing commands in the Asset and Disposal folders.
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Using the Calendar folder to view assets by date
The Calendar folder lists the client’s assets in a calendar format by date of 
acquisition, date of disposal or both. The Calendar folder opens to the current 
month and year, with the current date selected. Use the Calendar folder to locate 
assets and to find information about a specific asset.

Use the list near the top right corner of the Calendar folder to select Date 
acquired, Disposition date or Both.

Use the single arrows near the top left corner of the Calendar folder to move 
from month to month. Use the double arrows to move from year to year. Double-
click any date to review the complete asset list for that date.

Assets are identified by description and number in the Calendar folder. To see 
complete information about each asset that is listed for a specific date, double-
click that date.

Finding an asset
To find a specific asset:

1 Open the client file.
2 Go to the Asset menu and select Find Asset.
3 Enter the asset number of the asset you want to find, then click OK. (If 

you’re in the Calendar folder and Both is selected, change the selection to 
Acquisition date or Disposition date.)
• If you’re working in the Schedule folder, Fixed Asset Manager selects the 

asset.
• If you’re working in the Asset, Disposal, Projection or Notes folder, 

Fixed Asset Manager shows the applicable information for the asset.
• If you’re working in the Calendar folder, Fixed Asset Manager selects 

the date the asset was acquired or disposed.
• If the client file doesn’t include an asset with the asset number you typed 

in the Find Asset window, Fixed Asset Manager informs you that the 
asset number does not exist.

Viewing the next or previous asset
If you’re working in any folder other than the Calendar folder and you want to 
see information about the asset with the next highest asset number, click the Next 
Asset button on the toolbar.
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If you’re working in any folder other than the Calendar folder and you want to 
see information about the asset with the next lowest asset number, click the Prev 
Asset button on the toolbar.

Copying and deleting assets
To copy assets:

1 Go to the Schedule folder.
2 Select the assets that you want to copy.

3 From the Edit menu, select Copy.
4 From the Edit menu, select Paste.

Fixed Asset Manager assigns the next available asset numbers to the copied 
assets.

To delete assets:

1 Go to the Schedule folder.
2 Select the assets you want to delete.
3 From the Asset menu, select Delete Asset.
4 Click Yes to confirm the deletion.

Using property labels
Use the Labels feature to print property labels for your clients’ assets. Use these 
labels to identify your clients’ assets when they are sold, moved or inventoried.

Previewing labels
Before you print labels, preview the label to make sure it provides enough space 
for the information that you want to print.

To preview a label that’s open in the Label Editor:

Tip: To select consecutive assets, hold down the Shift key while you click the first 
asset and the last asset in the sequence of assets that you want to copy.
To select nonconsecutive assets, hold down the Ctrl key while you click each 
asset that you want to copy.
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1 From the File menu, select Print Preview, then select Labels. Or, from the 
Reports menu, select Display Labels.

2 Select the basis, asset sort set, query criteria and the time frame you want to 
use for the labels.

3 When you finish making selections, click OK.
4 If the Printer Warning window appears, read the information, click the 

Diagram tab if appropriate, then click OK.

Select a time frame.

Select an asset 
sort set and a 
query criteria.

Select a basis.
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5 Examine the Print Preview window that appears.

6 Use the buttons near the top of the window as appropriate. Click Close to 
close the Print Preview window.

Printing labels

To print label:

1 From the File menu, select Print, then select Labels.
2 Select the label or labels, basis, asset sort set, query criteria and the time 

frame you want to use for the labels.
3 When you finish making selections, click OK.

Click these buttons to 
print the labels, to view 
other pages, to zoom 
in and out and to close 
the window.

Important: Before instructing Fixed Asset Manager to print any labels, make sure the 
appropriate labels are loaded in your printer.
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Using the Projection folder to review depreciation
In the Projection folder, you can determine the best method of depreciation for 
an asset by reviewing its projected depreciation.

To find projections for the asset that you’ve selected in the Schedule folder, click 
the Projection tab. The following projected depreciation for the asset appears:

This field Shows

Date Acquired The date the client began using the asset for business purposes, which is usually 
the asset’s date of purchase

Cost or Other Basis The value of the asset when it was placed in service

Tax System The applicable tax system

Method The applicable depreciation method

Special Depr. Allowance The amount of any Special Depreciation Allowance taken for this asset

Convention The applicable averaging convention

Life The amount of time over which depreciation may be deducted
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Using the Section 179/40% test
To determine whether the Section 179 deductions claimed for the current year are 
within allowed limits, or to calculate the percentage of assets acquired in the last 
three months of the year, use the Section 179/40% test. Perform these diagnostics 
after you enter client asset information and before you print reports or link the 
file to the client’s tax return.

To perform these tests, go to the Tools menu and select 179/40% Test. Review 
the Section 179 test, then click the 40% test to review mid-quarter totals.

Reviewing Section 179 limitations
The Section 179 test determines the total cost of all eligible Section 179 property, 
the total Section 179 expense deduction made, and how much of the deduction 
exceeds federal limits for the active year.

Section 179 Deduction The amount of the Section 179 deduction to be taken in the current year or the 
amount that has been taken in a prior year for this asset

Business Percentage The percentage of time the active asset is used for business purposes

Year The number of years since the asset was placed in service

Year Ending The year end based on the client’s beginning and ending dates. Short-year and 
fiscal-year dates are shown when applicable. The projection assumes the same 
beginning and ending year dates for future years based on the active-year dates.

Current Depreciation The amount of depreciation that can be deducted for the year in question

Accumulated Depreciation The amount of depreciation that has been deducted thus far for the active asset

Unrecovered Basis The amount of the asset’s value that has not yet been depreciated

Basis tabs Projection information appears for the active basis. To change the basis, click 
the Basis tab at the bottom of the screen.

This field Shows
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Reviewing the Mid-Quarter 40% test
Fixed Asset Manager totals the cost of all assets purchased in the active year and 
all assets purchased in the last quarter of the active year. If the percentage of 
assets purchased in the last quarter is greater than 40%, you can convert these 
assets to the mid-quarter convention.

Using the Client Totals Summary
Use the Client Totals Summary to review the accumulated cost and depreciation 
before and after current-year calculations for each basis supported in a client file.

The Switch to MQ 
Convention button 
appears in the window only 
if over 40% of the MACRS 
tangible assets acquired 
this year were acquired in 
the last three months.

Click this button to apply 
the mid-quarter convention 
to all MACRS tangible 
assets placed in service 
this year.
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To see the Client Totals Summary, go to the View menu and select Client Totals.

This field Shows

Cost/Basis
Beginning Of Year

The total amount entered as cost or basis for all assets at the beginning 
of the current year

Additions The total cost or basis of all assets placed in service in the current year

Deletions The total cost or basis of all assets sold in the current year

Cost/Basis
End Of Year

The net amount of the following calculation:

Cost/Basis Beginning Of Year (BOY)
+ Additions
- Disposals

Accumulated Depreciation
Beginning Of Year

The total amount calculated as accumulated depreciation for all assets 
at the beginning of the current year

Current Year Depreciation The total calculated depreciation to be taken for the current year

Disposals The total calculated current depreciation for assets marked as sold

Accumulated Depreciation
End Of Year

The net amount of the following calculation:

Accumulated Depreciation Beginning Of Year (BOY)
+ Current Year Depreciation
- Disposals

Display totals for the current query The totals of the assets listed in the Schedule folder. When this option 
is not selected, the totals are shown for all assets.
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Recalculating assets
To have the program review and compute each calculated field for all assets:

1 Go to the Tools menu and select Recalculate all assets.

2 In the Recalculate All Assets window, select one of the following options:
• Do not recalculate prior depreciation values.
• Recalculate prior depreciation values that are zero.
• Recalculate all prior depreciation values.

3 Click OK.

Using the calculator
While you’re working in Fixed Asset Manager, you can use the on-screen 
calculator to verify depreciation calculations and perform other calculations.

To open the calculator, go to the Tools menu and select Calculator.

Fixed Asset Manager uses the standard Windows calculator. For information on 
how to use this calculator, go to the calculator’s Help menu or see your 
Windows® documentation.
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To use another calculator program that you have on your hard disk drive:

1 Go to the Tools menu and select Program Options.
2 Click the Tools tab.
3 Enter the path and file name for the calculator that you want to use or click 

the Browse button to locate the calculator file.
4 Click OK.
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Understanding Report options
Fixed Asset Manager provides a variety of report options to help you manage and 
track your clients’ assets. You can use the set of pre-defined reports and labels 
included with Fixed Asset Manager.

Using pre-defined reports
Fixed Asset Manager provides many pre-defined reports that you can use to 
manage and track your clients’ assets. This section describes each report and 
explains the requirements for completing each report.

Previewing a pre-defined report
To preview a pre-defined report:

1 From the Reports menu, select Display Report.
2 Select a pre-defined report from the list.

Important: Reports are based on the data that’s been entered in the client’s data file. 
Before you prepare a report, enter all relevant information, including complete 
information about each asset in the Asset folder.
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3 Select a basis, a date through which you want to create the report, how you 
want to sort the assets and the type of query criteria you want to use, if any.

4 Click OK.

For information about organizing your reports, refer to the section titled 
“Organizing reports into report lists” on page 88.

For information about printing your reports, refer to the section titled “Printing 
reports” on page 91.

Reviewing each pre-defined report
The following table describes the purpose of each pre-defined report:

Tip: To preview more than one pre-defined report at a time, hold down the Ctrl 
key while you click each report name.

Use this report For this purpose

ACE Adjustment 
Calculation

To determine the total ACE adjustment needed to compute a tax return for a 
corporation. Assets are grouped by category and sorted by asset number within 
each group.

Amortization Schedule
by G/L Account Number

To see a summary of the activity of the amortized assets. Assets are grouped by 
general ledger account number and sorted by asset number within each group.

Amortization Schedule
by User Defined 1 to 5

To see a summary of the activity of the amortized assets, grouped by one 
user-defined classification. (There is a report for each user-defined field that 
you use.) Assets are grouped by the user-defined field and sorted by asset 
number within each group.

AMT Adjustment 
Calculation

To print the necessary information for AMT depreciation adjustment reporting 
(Federal depreciation - AMT depreciation = AMT adjustment). Assets are 
grouped by category and sorted by asset number within each group.

Asset Disposition by
Asset Sale Description

To see a summary of disposition information according to the sale description 
assigned to each asset. Assets are grouped by asset sale description and sorted 
by asset number within each group.

Asset, Basis and Disposal 
Detail Report

To print the asset details for each asset in the Asset and Disposal folders that 
you see on-screen.

Assets Acquired in the 
Current Year

To see a summary of each asset purchased in the current year. Assets are 
grouped by general ledger account number and sorted by acquisition date 
within each group.
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Organizing reports into report lists
You can select the reports you want to associate with your client using the Report 
List Organizer and create a custom report list. Having a custom report list allows 
you to batch print reports.

Depreciation Schedule
by G/L Account Number

To see an activity summary for each asset, grouped by general ledger account 
number. Assets are sorted by acquisition date within each group.

Depreciation Schedule
by User Defined (1 to 5)

To see an activity summary for each asset, grouped by one user-defined 
category. (There is a report for each user-defined field that you use.) Assets are 
sorted by asset number within each group.

Lead Schedule by Category To see an activity summary for each asset, grouped by category, in a traditional 
lead schedule format. Assets are sorted by asset number within each group.

Lead Schedule by
G/L Asset Account

To see an activity summary for each asset, grouped by general ledger account 
number, in a traditional lead schedule format. Assets are sorted by asset 
number within each group.

Lead Schedule by Location To see an activity summary for each asset, grouped by location, in a traditional 
lead schedule format. Assets are sorted by asset number within each group.

Lead Schedule by
Tax Form and
Property Description

To see an activity summary for each asset, grouped by tax form and property 
description, in a traditional lead schedule format. Assets are sorted by asset 
number within each group.

Monthly G/L Accumulated 
Account Summary

To see the total monthly cost additions and deletions and their beginning, and 
ending balances. This report is grouped by General Ledger Asset Account. 
Assets without assigned account numbers are grouped by “No Account 
Number.”

Monthly G/L Asset 
Account Summary

To see the total monthly accumulated depreciation/amortization additions, and 
deletions and their beginning and ending balances. This report is grouped by 
General Ledger Accumulated Depreciation and Amortization account. Assets 
without assigned account numbers are grouped by “No Account Number.”

Personal Property Schedule 
by Year of Acquisition

To see a summary of depreciation amounts for assets that you marked as 
personal property. Assets are grouped by the year each asset was placed in 
service, and sorted by acquisition date within each group.

Projection by Category To see a five-year projection for each asset. Assets are grouped by category, 
and sorted by asset number within each group. 

Remaining Basis Over 
Remaining Life Report

To identify assets that were not fully depreciated. Assets within this report are 
grouped and subtotaled by category.

Use this report For this purpose
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To organize a report list:

1 From the Reports menu, select Report List Organizer.
2 Go to the Report lists available for the current directory area and select 

the report list that you want to use, then click OK.

• To create a new report list, click New. When the Add Report List 
window appears, type a name for the report list that you want to create, 
then click OK.

• To edit an existing report list, click Edit. When the Edit Report List 
Name window appears, enter a new name, then click OK.

• To delete selected reports from the report list the reports, select the report, 
and then click Delete. When the confirmation window appears, select 
Yes.

3 If you want Fixed Asset Manager to print all of the reports in the report list 
you’ve created each time you print reports, select the When printing, select 
all reports in list to print together check box. This option allows you to 
batch print all the reports in your custom report list.

4 If you want to print only the assets selected in the Schedule folder, select the 
When printing, print only the assets selected in the Schedule check box.

5 If you want to add a report to the report list, select the report in the Available 
Reports list, and then click Add. If you want to remove a report from a 
report list, select the report in the Selected Reports list, and then click 
Remove. Click OK to save your changes and close the window.
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Previewing reports in the report lists
After you create your report lists, you can preview one or several reports at a 
time.

To preview reports:

1 From the Reports menu, select Display Report.

2 Go to the Type list, and select the report list that you want to preview.
3 Select the name of the depreciation reports that you want to preview, the type 

of depreciation basis you want to use for the reports, and the year that you 
want the reports to cover.

4 Use the Sort assets by list to select the sort method and the Apply query 
criteria list to select query type or select the Selected Assets check box to 
preview only the assets you have selected in the Schedule. 

5 Click OK to preview the reports.

Tip: You can also click the Print Preview icon on the toolbar, then select Reports.

Select the reports 
that you want.

Select the basis 
totals you want.

Select the report 
list that you want.

Preview only the 
assets selected in 
the Schedule.
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6 Review the first report that you selected.
7 To preview a different report, select the report from the drop-down list.
8 When you’re done reviewing the reports, click Close.

Printing reports
After you’ve organized and previewed your reports, you can print one or several 
reports at a time.

To print a report:

1 From the File menu, select Print, then select Reports.
2 From the Type list, select Reports.
3 Select the reports that you want to print.
4 Select the basis you want to use and choose the date or number of months 

you want to use for this report.
5 Go to the Print assets area and choose the sort method and query criteria or 

select the Selected Assets check box to print only the assets you have 
selected in the Schedule.

6 Click OK to print the reports.
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Understanding export procedures
To copy asset information, including computed depreciation, from a Fixed Asset 
Manager client file to the client’s ProSeries return, you need to:

1 Prepare the client’s Fixed Asset Manager data.
2 Export the client’s data from Fixed Asset Manager into an export file.
3 Import the client’s data from the export file into ProSeries.

Preparing a client’s data for export
To prepare a client’s Fixed Asset Manager data for export into a ProSeries tax 
return, you need to:

● Make sure you selected the correct type of return for the client
● Link an asset to the appropriate form for each return

Selecting the type of return
When you create a company in QuickBooks, one of the first things you do is 
select the client’s type of return, such as Form 1120, Form 1120S, Form 1065 or 
Form 1040.

To change or review this choice after you’ve created the company in 
QuickBooks:

1 Access QuickBooks and open the company associated with the Fixed Asset 
Manager data you want to export.

2 From the Company menu, select Company Information.
3 Confirm or change the tax return type for the client using the Income Tax 

Form Used option.
4 Click OK.

Linking assets to a return
Next, you need to link each asset to the appropriate form in the client’s tax return. 
To do so, go to the Link to Federal Form section of the Asset folder. When 
multiple properties apply, enter or select the name of the property with which the 
asset is to be associated on the tax return.
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Creating an export file
After you create links for the assets that you want to report on the client’s tax 
return, you create an export file containing the asset information that you will 
import into the client’s ProSeries tax return.

To create an export file from Fixed Asset Manager:

1 From the File menu, select Export, then ProSeries Tax, then Export.
2 Follow the instructions provided on each screen.
3 Once the transfer is complete, Click OK.

Exporting information to other applications
This section describes how to export information from Fixed Asset Manager to 
Microsoft® Word, Microsoft® Excel, and an ASCII or Comma-Separate (CSV) 
file.

Exporting data to Microsoft Excel
To export data to an Excel spreadsheet:

1 Make sure Microsoft Excel is installed on your computer.
2 In Fixed Asset Manager, go to the File menu, select Export, then select 

Excel Spreadsheet.
3 When the Export to Excel complete message appears, click Yes to view the 

spreadsheet.
4 Save the spreadsheet in Microsoft Excel

Exporting data to Microsoft Word
To export data to a Word document:

Important: The property name must be typed exactly as it is typed in the ProSeries tax 
product to which you are exporting. If the property name appears differently, 
ProSeries creates a new property with that name.

Tip: Fixed Asset Manager exports data from the Schedule folder based on the 
active column set, sort set, query and basis. To export other data, create a 
unique column set, sort set, query and basis.
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1 Make sure Microsoft Word is installed on your computer.
2 In Fixed Asset Manager, go to the File menu, select Export, then select 

Word Document.
3 When the Export to Word complete message appears, click Yes to view the 

Word document. The data appears in a table.
4 Save the document in Microsoft Word.

Exporting to an ASCII file
To export data to an ASCII file:

1 Go to the File menu, select Export, then select ASCII File.
2 When the Export to ASCII File message appears, type a file name and click 

Save.
The file name text box includes the.txt extension.

Exporting to a comma-separated file
To export data to a CSV file:

1 In Fixed Asset Manager, go to the File menu and select Export, then select 
Comma Separated File.

2 When the Export to Comma Separated File message appears, type a file 
name and click Save.
The file name text box includes the .csv extension.

Preparing for next year
After you file a client’s tax return and back up the client files, you’re ready to 
prepare the clients’ assets for next year’s depreciation calculations.

To prepare assets for next year:

1 From the Tools menu, select Prepare for Next Year.
2 Review the information in the Prepare for Next Year window.
3 If the client is an 1120 corporation, indicate whether the corporation will 

qualify for the small corporation AMT exemption next year.

Important: You cannot make modifications to or create reports for prior-year information. 
Remember to back up your client files and print any necessary reports before 
you perform these steps.
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4 Click Yes to begin the Prepare for Next Year procedure.
This procedure does the following:
• Removes assets that were disposed of in the current year
• Adds current depreciation to prior year depreciation
• Updates the unrecovered basis fields
• Calculates depreciation for the new year
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Understanding tax worksheets
Fixed Asset Manager provides the following tax worksheets that can help you 
complete the depreciation-related portions of your clients’ returns:

● Form 4562 Part I — Section 179 Summary Copy
● Form 4562 Part II & III — Lines 15, 16 and 17
● Form 4562 Part III — Lines 19 and 20
● Form 4562 Part IV — Summary
● Form 4562 Part V — Listed Property
● Form 4562 Part VI — Amortization
● Form 4797 Part I — Property Held More Than One Year
● Form 4797 Part II — Ordinary Gains and Losses
● Form 4797 Part III — Gains from Disposition of Depreciable Property
● Form 4626 Depreciation Adjustments and Tax Preferences
● Form 4626 ACE Worksheet
● Form 4626 Gain/Loss Adjustments

Fixed Asset Manager completes each worksheet automatically using the 
information in the client’s file.

Previewing tax worksheets
To preview a tax worksheet with a client’s data:

1 From the Reports menu, select Display Tax Worksheet.
2 In the Print Preview window, go to the Type list and select the worksheet 

that you want to preview.
3 Click OK.

The tax worksheet appears.
4 Use the buttons near the top of the window to magnify or move around the 

form.
If you selected more than one tax worksheet, each worksheet is included in 
the list that appears near the top of the window. To view a different 
worksheet, select that worksheet from the list.

5 When you finish previewing worksheets, click Close.

Important: The Fixed Asset Manager tax worksheets do not replace the IRS forms in a tax 
return. You must always include the actual IRS forms with the return.
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Printing tax worksheets
To print a tax worksheet with a client’s data:

1 From the File menu, select Print, then select Tax Worksheets.
2 Select the worksheets you want to print.
3 Click OK to begin printing.

Reviewing the tax worksheets
Each tax worksheet provides detailed information and totals for one or more lines 
on the tax return. This section briefly describes each tax worksheet.

Form 4562 Part I - Section 179 Summary Copy
Use this worksheet to complete Part I of Form 4562. The worksheet lists the cost, 
elected 179 cost and the elected 179 deduction totals for property that is not 
listed, and for property that is listed. You must calculate the business income 
limitation separately.

Form 4562 Part II & III - Lines 15, 16 and 17
Use this worksheet to complete Part II and III of Form 4562. The worksheet lists 
assets by asset class within each property that has been defined in Fixed Asset.

Form 4562 Part III - Lines 19 and 20
Use this worksheet to complete Part III of Form 4562. Information is given for 
lines 19 and 20 columns (c) through (g).

Form 4562 Part IV - Summary
Use this worksheet to complete Part IV of Form 4562. The worksheet lists the 
cost or other basis, elected 179 cost and depreciation deduction.

Form 4562 Part V - Listed Property
Use this worksheet to complete Part V of Form 4562. Within each defined 
property, the worksheet provides depreciation information for assets with a 
business percentage greater than 50%, and for assets with a business percentage 
less than or equal to 50%.
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Form 4562 Part VI - Amortization
Use this worksheet to complete Part VI of Form 4562. Within each defined 
property, the worksheet provides information for intangible assets acquired in the 
current year and in prior years. Current and prior year amortization information is 
given for each eligible asset.

Form 4797 Part I - Property Held More Than 1 Year
Use this worksheet to complete Part I of Form 4797. The worksheet provides 
disposal information for each asset that can be reported on Part I.

Form 4797 Part II - Ordinary Gains and Losses
Use this worksheet to complete Part II of Form 4797. The worksheet provides 
disposal information for each asset that can be reported on Part II.

Form 4797 Part III - Gains from Disposition of 
Depreciable Property
Use this worksheet to complete Part III of Form 4797. The worksheet provides 
complete disposal information for lines 19 through 26e for assets that can be 
reported on Part III.

Form 4626 Depreciation Adjustments and 
Tax Preferences
Use this worksheet to complete lines 2a, 2p and 2q of Form 4626, and lines 2a, 
2b and 2c of Form 4626 ACE Worksheet. For each defined property, the 
worksheet calculates AMT depreciation adjustments and tax preferences for 
assets subject to AMT depreciation.

Form 4626 ACE Worksheet
This worksheet closely resembles the Form 4626 ACE Worksheet. Use the 
information provided here to complete lines 2a through 2b(6). For each defined 
property, the worksheet calculates ACE adjustments for assets subject to ACE 
depreciation.
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Form 4626 Gain/Loss Adjustments
Use this worksheet to complete line 2e of Form 4626 and line 9 of the Form 4626 
ACE Worksheet. Fixed Asset Manager calculates Federal, AMT and ACE gain 
or loss for eligible assets within each property.
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